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安全について 

この説明書では、安全についての記載が 2 つに分類されています。 

• 製品についての注意事項 (身体や資産に対して損害、損傷を与える可能性があるために避けなくてはならないこと 

• 取り扱いについての注意事項 (製品を安全に使用するために避けなければならないこと) 
 

この説明書に記載してある注意事項は、各種見出し用語を使用することによりわかりやすく分類されています。 

見出し用語の分類と意味は下記の通りです。 
 
 

-製品の安全使用と操作 

警告：安全上の注意を守らないと重傷を負う可能性があることを示します。 

注意: 軽度の怪我や資産の損害をひきおこす可能性があることを示します。 

備考：データの損失やデバイスの損傷を招く可能性のある操作や状態に関連する重要な情報を示します。 

 

 

製品の安全な使用と操作 

本機は極微弱な高周波エネルギーを放射しており、敏感な医療機器の間近でのご使用は避けるようお願いしま

す。 
 
 

警告：付属の AC 電源コード、またはそれと同等の 2 ピンのものを使用してください。 

製品が異常な臭気や音を発したり、煙が出たりする場合は、ただちに機器の電源を切ってください。 
 

 

警告：製品を分解、修理、改造しないでください 

製品に対して分解、改造、我流の修理などを決して施さないでください。身体の怪我または資産損害 (製

品自体への損害と同様に)を与えることがありえます 

また、この事が原因による故障、不具合につきましては保証外となりますので、ご注意ください。 
 
 

警告：お使いの製品はおもちゃではありません。 

お子様がこの製品で遊ぶことのないようご注意ください。不正使用、お子様による不適当な取扱いは、重大な障害、損害

を引き起こすことがありえます。また、小さな部品やアクセサリーなどを飲み込むことにより窒息を引き起こす可能性もあり

ますので、お子様の手の触れるようなところへアクセサリーの類を置かないでください。 
 

 

注意： 

イヤホンを使用するときは、音量レベルを高くし過ぎしないでください。 音量が大きすぎると、聴力障害の原因となります。 
 

 

警告：火災や感電を引き起こす可能性がありますので、製品内部に水などの液体が入らないようにしてください。 

製品内に異物が入ったりしないようにしてください、また湿気の多いところや直射日光があたるところへの設置は避けてくださ

い。 

万一、異物や液体が製品内に入ってしまった場合には、すぐに電源ケーブルをコンセントより抜いて、販売店や弊社へ修理

依頼をしてください。 
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製品を接続する前に、この説明書のすべての項目をお読みいただき、指示に従ってください。また、あとからでもすぐ参

照できるように、この説明書はわかりやすいところに保管しておいてください。これらの説明書および製品そのものに記

載されているすべての警告および安全情報に従ってください。 すべての取扱説明書に従ってください。 

製品本体はある程度の熱を発しますので、空気の流れがおきるように周囲の空間を最低でも 10cm 程度は確保してくださ

い。また、製品はしっかりしたラックなどへ設置してください。ソファーやベッドなどのやわらかい表面の場所へは設置しない

でください。 

製品を本棚やキャビネットなどへ設置する場合は、換気の妨げにならないように、周囲へ物を置かないように

してください。 

ストーブやヒーターなどの熱源のそばへ製品を設置することは避けてください。 

製品は、背面パネルに指定されている電圧の電源の種類にて接続してください。 付属の電源ケーブルま

たはそれと同等のものを使用して、製品を電源コンセントに接続してください。 付属のケーブルを改造しな

いでください。 

電源ケーブルが折れ曲がったり何かの下敷きになって損傷を受けたりしないようにしてください。 

特に、両端のプラグ直後の部分にご注意ください。 
 

長期間製品を使用しない場合や、雷が鳴ったりしているときは、コンセントより電源ケーブルを取り外してください。 

下記の条件にあてはまる場合は、すぐに製品の使用をやめて、販売店や弊社へサービスを依頼してくださ

い。 

• 電源ケーブルが損傷している 

• 製品に衝撃があった、製品内へ液体が入ってしまった 

• 製品が水にぬれてしまった 

• 製品が操作を受け付けなくなった 

• 製品が落下、または何らかの形で損傷した 
 
 

設置の前に 

開梱するときには、本製品に輸送時の破損が無いことをお調べください。 

万一破損を発見された場合は、お買い上げ販売店か弊社までご一報ください。開梱後は、本体の他に下

記の内容物が入っているかどうかご確認ください。 
 

-同梱物の確認- 

• 電源ケーブル 

• USB ケーブル 

• 3P-2P 変換プラグ 

• リモコン（単 4 電池 2 本） 

• 保証書 

• 取扱説明書 

 

お引越しや、修理など本体を移動される際の破損等の事故を防ぐため、保証登録書と共に本製品の梱包

箱の保管をおすすめします。 
 
 

保証とサービスについて 

正しくお使いいただいているなかで、万一製品が故障してしまった場合は、ご購入日より 1 年間の保証をい

たします。しかし、弊社サービス以外による本体及び付属品の修正や、シリアル番号、購入日の書き換え

が見られる場合の保証は認められません。詳しくは、製品に添付されている保証書をご確認ください。 
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Introduction 

NuPrime DAC-9H は、AES および XLR 出力と PCM 384K および DSD 256 のデコード機能を備え、スタジオでのプロユース

も視野にいれて設計・開発されたリファレンスクラスの DAC です。4 つのデジタル入力と 1 ペアのアナログステレオ入力を備

えており、ハイエンドシステムにも最適な DAC+プリアンプとしても機能します。 DAC-9H と DAC-9 との相違点は、4.4mm の

「Pentaconn」ソケットと3.5mmのステレオミニヘッドフォン出力が追加されたことで、シングルエンドのアンバランス駆動とバ

ランス駆動に対応しています。 
 
 

最先端のバランス型ヘッドフォンアンプ 
DAC-9H ヘッドフォンアンプは、これまでドライブが困難とされてきたどんなヘッドフォンも十全に駆動するこ

とができます。出力は 4.4mm の Pentaconn ソケット、または 3.5mm のステレオミニソケットを介して接続し

ます。「Pentaconn」ソケット（日本ディックス社製）は、ヘッドフォンとケーブルメーカーが新製品および将来

において使用されるバランス型ヘッドフォン接続の新しい統一規格です。オーディオファイル品質のコンポ

ーネントと完全にバランスのとれたレイアウトにより、クロストークを最小限に抑え、チャネル分離をより優れ

たものにします。最大 1.2W の出力電力を供給するこの回路は、シングルエンドアンバランス型、およびバ

ランス型をサポートしています。両タイプの接続ともに、極めて高いレベルの透明性を提供することに加え、

それぞれの特徴を反映した風合いをお届けします。 

4.4mmのPentaconnソケットバランス出力を使用することで、バックグラウンドにノイズのない再生に納得し

ていただけるでしょう。サウンドステージは広大で、十分かつローエンドまで伸びやかな低音で強力な存在

感を示すパフォーマンスです。 
 
 

リファレンス LE クラス プリアンプ 
システムから余分なコンポーネントを省きたいと考えた場合、パワーアンプを直接駆動できるハイエンドのプ

リアンプはシステムの重要な役割となるでしょう。DAC-9H には、従来のハイエンドプリアンプから取り入れた

機能が含まれています。 

� ボリューム調整には高精度スイッチ抵抗ラダーネットワークを採用 

� 正確な音源レベルのマッチングのために、音量は入力ごとに個別に調整可能 

� 音量調整は 0.5 段階で 99 ステップ 
 
 

サウンドシステムの要 
オーディオシステムの中枢を担う DAC-9H は多彩な入力とデジタルフォーマットをサポートします。究極の

DACを設計するための第一段階として、世界最良の32-bitオーディオDAC-ICであるAK4490EQを採用。

数々のエディターズチョイスに選ばれ幾多の受賞歴を誇る製品群で培われた経験と最先端のソリューショ

ン、全ての開発にすぐに利用できる特許ノウハウが NuPrime DAC-9H をさらなる高みへと導きます。 
 
 
 
特徴 

� NuPrime SRC IC チップは超低ジッターと歪みを誇り、目標とするサンプリングレートまでダウンコンバ

ートする前に入力信号をメガヘルツオーダーまでアップサンプリング 

� AKM 最新世代 高音質プレミアム 32-bit ステレオ DAC(AK4490EQ)を採用。USB PCM 384 と DSD 

256 をサポートし、より滑らかで温かみのある音響特性を誇る最先端の DAC 

� 同軸並びに光入力（S/PDIF の他、DoP ストリームを出力可能な NuPrime の Omnia ポータブルデバ

イスをサポートするため）経由で DoP フォーマットのデコーディングも可能な NuPrime オリジナル回路 

� NuPrime オリジナルの除振アイソレーションフィート（特許出願中*） 

� 柔軟なフルマイクロプロセッサ調整によるセッティング内容のメモリ機能 

� システム適応性を実現するデジタル入力 5 系統とアナログステレオ入力 1 系統 

� ASIO2.1 と DoP 方式による DSD ネイティブ再生をサポート。DSD は入力ソースとして同一サンプルレ

ートでネイティブデコーディング 

� 極限までのノイズフロア低減を実現する入力段の超低ノイズ JFET 
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� 任意の音量設定で信号経路内には薄膜スイッチド・ラダー・ネットワークの抵抗器一個のみとなるよう、

音量を制御するための回路を実装 

� ソースの精密レベルのマッチングのため各入力において個別に音量調整が可能。DAC-9H と他のプリ

アンプまたは AV アンプと接続する場合には、音量を 0dB の 94 に設定（スルーアウト機能） 

� Windows 用の拡張ドライバーソフトウェア 

� Mac 用の標準ドライバーソフトウェア 

� 非同期転送モード 

� スタンバイモード時の低消費電力 
 
 
 
 

スペック 

入力 

• USB PCM/DSD デジタルｘ1 系統（PCM 384kHz まで / DSD DSD256 まで） 

• 同軸デジタル S/PDIF ｘ1 系統（PCM 192K まで DoP フォーマットで DSD64 をサポート） 

• 光デジタル S/PDIF ｘ1 系統（PCM 192K まで DoP フォーマット で DSD64 をサポート） 

• AES バランス XLR ｘ1 系統 

• アナログステレオ RCA ｘ1 系統（A/D 変換は行わずアナログ入力はプリアンプによって 

• アナログ出力に直接選択されます） 
 

出力 

• ステレオ RCA ｘ1 系統（最大出力 4V） 

• ステレオ XLR バランス ｘ1 系統（最大出力 8V） 

• 光デジタル S/PDIF ｘ1 系統 

• ヘッドフォン用バランス 4.4mm Pentaconn ソケット 

• ヘッドフォン用 3.5mm ステレオミニソケット 
 
 

• USB サンプリングレート: 44.1KHz, 48KHz, 88.2KHz, 96KHz, 176.4KHz, 192KHz, 352.8KHz, 384KHz  

DSD  2.8MHz(64), 5.6MHz(128),  11.2MHz(256) *MAC OS は 5.6MHz まで 

• S/PDIF サンプリングレート: 44.1KHz, 48KHz, 88.2KHz, 96 KHz, 176.4KHz, 192KHz, 352.8KHZ, 384KHz（同軸） 

*光の場合は 96kHz/24bit まで 

• ビット解像度: 16-32 ビット 

• 全高調波歪率: 0.0005% 

• SN 比：  113  dB 以下 

• 再生周波数帯域: 10Hz ～  80KHz 

• サイズ: H55 × W235 × D281 mm *端子、脚含む 

• 重量: 2.3Kg 

• 世界対応 AC 電源: スイッチ切替え （90-130VAC/210-250VAC  ） 

• ACヒューズ：1Aスローブロー/250VAC 
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1. 電源

   

2.  3.5mm

3.  IR

4.  ディスプレイ

5.  4.4

6.  ボリュームコントロール

 

 
 

ディスプレイ
 

 
PCM Sample rate:

 

 
 

クイックスタートガイド

パネル: 

電源 / 入力セレクタ

   電源  : 約

入力セレクター

3.5mm  イヤフォン

IR リモコンセンサー

ディスプレイ 

4.4mm  Pentaconn

ボリュームコントロール

ノブを時計

ノブを反時計

ノブを軽く

ディスプレイ: 

PCM Sample rate: 

44.1 

48 

88.2 

96 

176.4 

192 

352.8 

384 

 

クイックスタートガイド 

セレクタ 

約 3 秒間押し続

セレクター: 軽く回す

イヤフォン出力 

リモコンセンサー 

 

Pentaconn バランス型

ボリュームコントロール 

時計まわりに回すと

反時計まわりに回

く押すと音量が

 

 DSD Sample rate :

 

 

続けることでスタンバイからの

すことで入力チャンネルが

型イヤフォン出力

すと音量が上がります

回すと音量が下

がミュート/ミュート

DSD Sample rate :

d2.8 (64) 

d5.6 (128) 

d11.2 (256) 

  

けることでスタンバイからの

チャンネルが切

出力 

がります 

下がります 

ミュート解除になり

DSD Sample rate : Volume display:

 

 

けることでスタンバイからの ON/OFF を行

切り替わります 

になります 

Volume display:

00 ~ 99 

行います 

 

Volume display: Inputs Display:

C1: Coaxial input

O2: Optical input

U3: USB input

E4: Extension port input

A5: Stereo analog input

A6: AES balance input

Inputs Display: 

C1: Coaxial input 

O2: Optical input 

U3: USB input 

E4: Extension port input

Stereo analog input

AES balance input

 

 

E4: Extension port input 

Stereo analog input 

AES balance input 
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入力： 

C1: 同軸デジタル入力（CD / DVD / BD プレーヤー、TV、同軸のソースを持つ任意のデバイス用の同軸入力） 

O2: 光デジタル入力（CD / DVD / BD プレーヤー、TV、および光源を備えた任意のデバイス用の光入力） 

U3: USB 入力（コンピュータ（PC / MAC）および NAS デバイス用の USB 入力） 

E4: 拡張入力（Bluetooth および WiFi モジュール用の拡張ポート *オプション） ※日本未対応 

A5: アナログ RCA 入力（A/D 変換は行わずプリアンプによってアナログ出力に直接選択されます） 

A6: AES バランス入力 

• DAC-9H では NAS を接続した際、さまざまなブランドやカスタム仕様があるため、すべての NAS が動作し互換性があ

ることを保証するものではありません。 

出力: 

SPDIF 出力：光デジタル出力（最大 24 ビット/ 195KHz）（DSD 再生中は出力されません） 

アナログ出力：ステレオ RCA 出力（ライン出力：サブウーファー対応） 

：XLR バランス出力(完全バランスの XLR バランス出力) 

ヘッドフォン出力：4.4mm バランス（出力：350mV/1kHz /560Ω 負荷 ） 

            ：3.5mm （出力：1.2W/1kHz /33Ω 負荷 ） 

                 （出力：100mW/1kHz /560Ω 負荷 ） 

※日本未対応 

背面パネル: 

A5 

A6 
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AES / EBU (XLR FEMALE )
 

 

 

 

 

 

 

 

バランスステレオオーディオ

 

 

 

 

 

 

 

 

AC インレット

 

 

 

 

 

 

 

AC電圧切替

 

本体底面

してください

日本国内出荷分
 
 
 

 

AES / EBU (XLR FEMALE )

バランスステレオオーディオ

インレット 

電圧切替スイッチ

 

本体底面にある AC

てください。 

日本国内出荷分は

 

AES / EBU (XLR FEMALE )ピン

バランスステレオオーディオ出力 (XLR FEMALE )

スイッチ: 

AC 電圧セレクタスイッチが

は 115V の位置

 

Pin 1 : Ground
Pin 2 : 

Pin 3 :

出力位相
Pin 1 : Ground
Pin 2 : 

Pin 3 :

配置： 

(XLR FEMALE )

セレクタスイッチがご

位置に設定済みです

  

Pin 1 : Ground 
Pin 2 : ＋ 

Pin 3 : ― 

位相：正相 
Pin 1 : Ground 
Pin 2 : ＋ 

Pin 3 : ― 

Pin 1 : Live Conductor
Pin 2 : Ground Conductor : PE

Pin 3 : Neutral Conductor

(XLR FEMALE )ピン配置： 

ご使用になる国

みです。日本国内

Live Conductor：
Ground Conductor : PE

Neutral Conductor

 

国の適切な電圧

日本国内ではこの位置

出力位相：反転
Pin 1 : Ground
Pin 2 : − 

Pin 3 : ＋ 

：L 
Ground Conductor : PE 

Neutral Conductor : N 

電圧に切り替えられていることを

位置で使用します

反転 
Pin 1 : Ground 

えられていることを

します。 

えられていることを確認
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リモコン

 

 

リモコン: 

 

 
: 電源

DIS: ディスプレイを

CD+: 入力

CH-: 入力

Vol +: 

Vol –: 

Mute: 

C1： 同軸

O2： 光

U3： USB

E4： 拡張

A5： アナログ

A6： AES

注

 

 

電池交換

電池を

 

 

 

 

 

電源 On/Off 

ディスプレイを表示

入力切替 次のチャンネルへ

入力切替 前のチャンネルへ

Vol +: 音量を上げる 

: 音量を下げる 

Mute: ミュート/ミュート

同軸 入力を選択

光 入力を選択

USB 入力を選択

拡張ポートを選択

アナログ RCA 入力

AES バランス入力

注：A5 を押して

電池交換： 

を交換するには

 

 

表示する 

のチャンネルへ 

のチャンネルへ 

 

 

ミュート解除 

選択 

選択 

選択 

選択 ※日本未対応

入力を選択 

入力を選択 

して A5 と A6 の

するには、背面のカバーを

日本未対応 

 

の入力選択を切

バーを取り外して

切り替えます 

して電池を入れ

 

れ替えてくださいてください。 
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MAC での再生方法:  
PCM 

1. MAC と USB ケーブルで接続してから DAC-9H の電源を入れて、USB 入力を選択します。ドライバーのイン

ストールは必要ありませんので、USB Audio device として MAC が認識するのを待ちます。 

2. Audio Midi Setup にて、”default Input device“ ” Output device “として NuPrime DAC-9H を選択します。  

3. 出力サンプルレートをドロップダウンメニューより選択します。 

4. SPDIF 出力からも出力可能です。 

 

DSD 

1. DSD 再生用のソフトウェアを Mac にインストールしておきます。 

( Audirvana   https://audirvana.com/ 15 日のトライアルなどあり。詳しくはソフトウェア会社へ確認をしてください)。 

MAC と USB ケーブルで接続してから DAC-9H の電源を入れて、USB 入力を選択します。 

2. 設定にて、Audio System の項目で “NuPrime DAC-9H”を Default Device として指定する。 

3. Native DSD Capability の項目で “DSD Over PCM standard 1.0”を選択する。 

4. SPDIF 出力からは出力不可能です。 

 

 

 

Windows PC での再生方法: 
PCM 

1. www.nuprimeaudio.com より、最新のドライバーをダウンロードしてください。 

2. Windows PC と USB ケーブルで接続してから DAC-9H の電源を入れて、USB 入力を選択します。 

3. あらかじめダウンロードしておいてドライバーのインストールを行います。 

4. コントロールパネル→サウンドで、 “NuPrime DAC-9H”を規定値として設定します。

 

DSD 

DSD再生用のソフトウェアをWindows PCにインストールします。 

注意！専用ドライバー、各プラグインにつきましては不定期に更新されます。必ず最新のプログラムをインストール

してください。 

 

1. foobarメディアプレーヤー http://www.foobar2000.org/download 

2. ‘SACD’プラグインを http://sourceforge.net/projects/sacddecoder/files/latest/download より適当な場

所にダウンロードしておきます。 

a. foobarの File->Preferences and select Components を選択 

b. “Install…” ボタンをクリック 

c. ダウンロードしておいたSACDプラグインのzipファイルを選択 

d. “Apply” ボタンをクリックしてから、foobarを再起動します 

 

3. ASIO プラグインを http://www.foobar2000.org/components/view/foo_out_asio より適当な場所にダウン

ロードしておきます。 

a. foobarの File->Preferences and select Components を選択 
b. “Install…” ボタンをクリック 
c. ダウンロードしておいたASIOプラグインのzipファイルを選択 

d. “Apply” ボタンをクリックしてから、foobar を再起動します 
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4. 出力デバイスの

a. Playback
b. “ASIO foo_dsd_asio” 
 

 
5. ASIO出力

a. Playback
b. ASIO Driver: “NuPrime ASIO Driver” 
c. DSD Playback Method: “ASIO Native” 
d. PCM to DSD Method: “None” 
e. Fs: “DSD128” 

 

デバイスの設定

a. Playback->Output
b. “ASIO foo_dsd_asio” 
 

出力の設定 
a. Playback->Output
b. ASIO Driver: “NuPrime ASIO Driver” 
c. DSD Playback Method: “ASIO Native” 
d. PCM to DSD Method: “None” 
e. Fs: “DSD128” 

 

設定 
>Outputを選択

b. “ASIO foo_dsd_asio” を

 
>Output->ASIO

b. ASIO Driver: “NuPrime ASIO Driver” 
c. DSD Playback Method: “ASIO Native” 
d. PCM to DSD Method: “None” 
e. Fs: “DSD128” を選択 

  

選択 
を選択 

>ASIOを選択。” foo_dsd_asio” 
b. ASIO Driver: “NuPrime ASIO Driver” 
c. DSD Playback Method: “ASIO Native” 
d. PCM to DSD Method: “None” を選択

 

 

foo_dsd_asio” 
b. ASIO Driver: “NuPrime ASIO Driver” を選択 
c. DSD Playback Method: “ASIO Native” を選択 

選択 

foo_dsd_asio” をダブルクリックする

 

をダブルクリックする 
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6. SACDプラグインによるDSD再生の設定 (DSDはPCM変換しない) 

a. Tools->SACDを選択 
b. ASIO Driver Mode: “DSD” を選択 
c. PCM Sample Rate: “352800” を選択 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
本資料に掲載の情報は2018年12月現在のものです 
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